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Excel Tables – 
Database Technology Comes to Spreadsheets 

 
 
 

 
 
 
 
 

Excel Tables are nothing more than database technology similar to that found in Microsoft Access. You 
can use Tables to overcome the difficulties of working with large amounts of data in Excel. Think of them 
as two-dimensional Excel databases with special functionality. In this session, you will learn about the 
advantages of working with Tables, practical applications of using Tables in your Excel workbooks, and 
some of the ways Tables can streamline Excel-based processes, while simultaneously improving 
accuracy. 
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Introduction 
Excel Tables are nothing more than database technology similar to that found in Microsoft Access. You 
can use Tables to overcome the difficulties of working with large amounts of data in Excel. Think of them 
as two-dimensional Excel databases with special functionality. In this session, you will learn about the 
advantages of working with Tables, practical applications of using Tables in your Excel workbooks, and 
some of the ways Tables can streamline Excel-based processes, while simultaneously improving 
accuracy. 

 
 

Learning Objectives 
Upon completing this session, participants should be able to: 

 
• Differentiate between an ordinary data range and a Table; 

 
• Create structured reference formulas and list their benefits over formulas built using ordinary 

cell referencing; 
 

• Select complete rows or columns of data in a Table quickly; 
 

• Utilize advanced filters in Tables to identify unique or duplicate records; 
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Excel Tables for Reporting and Analysis 
Excel Tables embody database technology similar to that found in Microsoft Access. They are designed 
to overcome the difficulties of working with large data sets in Excel. A table is nothing more than a list of 
data in which each column has a heading or field name, and each row represents a record. Think of 
tables as two-dimensional Excel databases with special functionality. In this session, you will learn about 
the advantages of working with tables, practical applications for using tables in your Excel workbooks, 
and some of the ways tables can streamline Excel-based processes while simultaneously improving 
accuracy. 

 
Many worksheets are used to manipulate lists – two-dimensional data sets of employees, customers, 
vendors, or products, etc. The Table features in Excel are designed to ease and enhance the way users 
sort, filter, format, and analyze list information. Here are some of the built-in features for managing and 
manipulating tables. 

 

• Auto Expansion – Tables expand automatically to include new data entered in adjacent rows or 
columns. All styles, calculations, data validation, and conditional formats are applied to the 
extensions. 

 

• Sorting – Users can sort on unlimited columns and on font or fill colors. Sorts can be made case- 
sensitive. 

 

• Filtering – Users can filter on single or multiple criteria, icon sets, or on dynamic dates, such as 
last week or last month. 

 

• Formula Replication – Any formula created in an adjacent column to make calculations on Table 
data is automatically replicated across all rows. 

 

• Duplicate Data – Users can highlight or remove duplicate rows with a few simple commands. 

• Table Styles – A large gallery of Table styles is available for formatting tables automatically. 
Styles with banded rows auto-adjust the color bands for record additions, deletions, sorting, and 
filtering. Styles interact with Themes to provide greater consistency in formatting tables. 

 

• Structured Referencing – Formulas that reference elements of a Table can use row and column 
tags rather than cell references in the formula for clarity and ease of use. 

 
 

Creating a Table 
To create a Table in Excel using the default style, place the cursor inside of the data range and press 
CTRL + T. In the Create Table dialog box, confirm the Table range and check My Table has headers. Click 
OK to create the Table as shown in Figure 1. In this case, the default style shades every other row for 
readability. Drop-down filter arrows are visible at the top of each column. Click on the arrows to filter or 
sort the columns. Note that the arrows do not print on reports. Any columns that do not have a name in 
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the header row at the top of the data set will be named Column1, Column2, Column3, etc. These fields 
can be renamed by typing over the inserted labels. 

 

 
Figure 1 - Creating a Table Instantly with CTRL+T 

 
Alternatively, the table could have been created from the ribbon. Again, position the cursor inside the 
data range. Then, select Format as Table from the Home tab. Select the desired style from the gallery 
and then confirm the table range in the Create Table dialog box. Click OK to create the table. 

 

Using CTRL + T is a faster and easier way to create a table, but it always creates a table in the default 
table style. To change the default table style, click Home, Format as Table on the ribbon. Right-click on 
the style to be made the new default and select Set As Default. 

 

CTRL + T 

Styles interact with Themes. Themes contain attributes for fonts, line and fill effects, and the 
color palette. By changing the Theme, the colors and formats of a Table Style will be affected. 
To see the impact, select Themes from the Page Layout tab. Then, roll your mouse over the 
various themes and watch the Table formats change. Themes give users even greater flexibility 

 
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Tables can be referred to by name. In default, Excel gives each table a generic name – Table1, Table2, 
Table3, etc. – based on the order in which the table was created in the workbook. Tables can be 
renamed with a descriptive name, such as Sales or Invoices, to make building formulas easier and more 
intuitive, especially when multiple tables are present in a single workbook. To rename a table, click in 
the Table Name box on the Table Tools, Design contextual tab, as shown in Figure 2. The rules and 
naming conventions that apply to Defined Names also apply to table names. 

 

 
Figure 2 – Giving Tables a Descriptive Name for Ease of Use 

 
 

Turning a Table into a Range 
Some accounting professionals may just want to format their lists with a few clicks. They don't need 
filtering, sorting, or any of the other advanced features, and they certainly don't want the filter buttons 
at the top of each column. Here's the trick. Create a table from the data, selecting the desired style in 
the process. Then, change the table back into an ordinary range from the ribbon by selecting Convert to 
Range on the Table Tools, Design tab. Click OK in the confirmation dialog box and the table will be 
transformed into an ordinary range again. Note that the table formatting remains! To turn off the filter 
buttons in a working table, position the cursor inside the table and click Filter on the Data tab or click 
Sort & Filter, Filter on the Home. The same processes can be used to turn on filtering again whenever 
it's needed. In Excel 2013, users can enable or disable the filter buttons on the Table Tools, Design 
contextual tab. Check or uncheck Filter Button in the Table Style Options group. 

 

 
Working with Tables 
Excel provides over sixty built-in table styles. Built-in styles can be customized easily to meet a user's 
needs with just a few clicks. In addition, users can build their own styles. The data in this example 
consists of four years of weekly sales data for ten fast-food restaurants. First, apply one of the built-in 

and consistency in formatting their tables. 

When a table is turned into a range, the table design becomes cell formatting, which may 
cause unexpected results if the range is later turned back into a table. If the table formatting is 
inconsistent, it can be repaired. Click inside the table. From the Ribbon, select Home, Format 
as Table. Right-click on the desired style in the gallery and choose Apply and Clear Formatting. 

 
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styles to the table. Then, use the check boxes in Table Style Options to explore how styles can be 
adjusted to meet specific needs. Note that altering the options in Table Style Options modifies the  
styles presented in the Table Styles gallery. Formatting tables with styles may be more effective if 
options are set before styles are applied. Figure 3 shows the results of our efforts. 

 

 

Figure 3 - Using Table Style Options to Adjust Table Formatting 
 

The easiest method for adding new records to a table is to position the cursor in the first blank row 
immediately below the table and begin typing. Press TAB to advance the cursor to the next field as you 
are typing. Alternatively, you can paste new data to the first blank row below the table. In either case, 
the table will automatically be expanded to include the rows typed or pasted. A new row can also be 
added by dragging the resize handle in the lower right-hand corner of the table to expand its size. Type 
in the following records or paste some new records into the sample table. 

 
1/7/2017   Hammond Store 6,529.40    6,662.75    6,878.64    6,951.27    6,463.56    6,599.14  6,673.20 

 
1/7/2017   Slidell Store 6,538.85    6,208.68    6,610.17    6,678.56    6,344.86    6,612.94  6,476.17 

 
Adding a column to a table is just as easy. In this case, the new column will contain a formula to total 
weekly sales by store for the last four years. Position the cursor in cell J1, type in the column label EOW 
Totals, and press ENTER. The table immediately expands to include the new column. Position the cursor 
in cell J2 and perform the following steps to create the formula. 

 
1. Type in "=SUM(" and move left one cell to cell I2. 

 
2. Then, hold down the SHIFT key while using the LEFT-ARROW to expand the range to include 

cells I2 through C2. 
 

3. Type in ")" to complete the formula and press ENTER. 
 

The formula will be copied down the column automatically to the extent of the data. Note the contents 
and format of the formula. 
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=SUM(WeeklySales[@,[Sun]:[Sat]]) 
 

The syntax of the formula displayed represents how Excel 2010/2013 creates structured referencing 
formulas. In Excel 2007, the formula would be presented as shown below. 

 

=SUM(WeeklySales[[#ThisRow],[Sun]:[Sat]]) 

The format of these formulas is known as structured referencing, which allows users to refer to columns, 
rows, or specific ranges within a table using tags. Try this: position your cursor in any cell outside of the 
table and then enter the formula below. 

 

=SUM(WeeklySales[Wed]) 

The formula entered totals sales for Wednesday – and it doesn't matter if the table contains 100 records 
or 500,000! Add another record, and the total will be updated to include whatever sales amount was 
entered for Wednesday. Detailed coverage of structured referencing will be forthcoming later in this 
session. 

 
At first glance, auto-expansion of tables may appear to be just another ho-hum feature, but beneath this 
facade lurks great power because any formula, chart, or PivotTable that references the table will 
automatically incorporate any new data added to the table. Have you heard of dynamic defined names? 
Tables in Excel can perform the same function but without the need for creating defined names based 
on complex formulas that average users have little chance of understanding or applying. 

 

 
Figure 4 - Adding Totals to a Table 
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Adding totals to a table is as easy as checking a box. First, position the cursor inside the table and select 
the Table Tools, Design tab on the ribbon. Then, check Total Row in the Table Style Options group. A 
grand total will be appended to the bottom of the table in the EOW Total column. Click on the cell 
containing the total and then click the drop-down arrow on the right to select the desired summarizing 
function. Select SUM, which is the default, to sum the column. Notice the formula in the Formula Bar. 
Excel entered the SUBTOTAL function instead of SUM, so that the total will not include hidden rows 
when the table is filtered. The process described is displayed in Figure 4. 

 
Each column in the table can be totaled independently of every other column. In other words, one 
column can be summed while another can be averaged or counted. Copy the total formula to the 
bottom of all sales columns by grabbing the auto-fill box in the lower right-hand corner of the cell 
containing the grand total and dragging the fill box across the row to the Sunday sales column. The 
demonstration table should now resemble the one shown in Figure 5. 

 

 
Figure 5 - Table with a Total Row Displayed 

 

The total row can be turned on or off in Table Style Options. The row remembers its content and layout 
so that the next time it is turned on, it will display just as it did before it was turned off. Further, if the 
total row is off the screen when it is turned on, Excel will rearrange the display so that the total row is 
visible. 

 

Sorting and Filtering 
In this example, the sales manager for Eat-a-Lot Fast Food would like to display last quarter's sales totals 
for just one of the restaurants. First, click the drop-down filter button at the top of the Location column 
and clear the Select All button in the record list. Next, select the Hammond location and click OK to 
apply the filter. To filter the results for the last quarter, click the drop-down filter button at the top of 
the EOW column and select Date Filters, Last Quarter. The table should resemble the one displayed in 
Figure 6. Note that the total row calculates the total sales for only the records displayed. Also, note the 
icons on the filter buttons of the filtered columns, which indicate that a filter is active. 
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Figure 6 - Table with Multiple Filters Applied 
 

This next example uses check data exported from QuickBooks. The owner of Hesson Flooring hired you 
to help him analyze his check payment history. In preparation for the engagement, he exported a list of 
check data from QuickBooks for the past two years. First, place the cursor in the data and convert it to a 
table with a style of your choice. Name the table Checks. 

 
To begin the analysis, filter the data on the Date field so that only checks for last year are displayed. 
Click on the filter button in the Date column. Click on Date Filters and then on Last Year to set the filter 
as shown in Figure 7. Only checks dated for the previous calendar year should now be visible in the 
table. 

 

 
Figure 7 - Setting a Predefined Date Filter 

 
Our attention is focused on those checks that were written for amounts of at least $1,000. Using a 
similar process, set a filter on the Amount field so that only checks with amounts of $1,000 or more are 
displayed. Click on the filter button in the Amount column. Click on Number Filters and then on Greater 
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Than Or Equal To. In the Custom AutoFilter dialog box, enter 1000 as the amount. Click OK to set the 
filter as shown in Figure 8. Only checks with amounts of $1,000 or more should now be visible in the 
table. 

 

 
Figure 8 - Setting a Filter on Numerical Data 

 

Sort the data so that the desired information is presented more clearly. Click on the filter button in the 
Amount field. Select Sort Largest to Smallest so that the largest check amounts are at the top of the list. 
Next, do another simple sort so that the name of the payee is in alphabetical order. Click on the filter 
button in the Name field. Select Sort A to Z so that the list is in ascending order. Note that when a sort is 
active, the filter button at the top of a sorted column has a small arrow pointing up or down to indicate 
the direction of sort. 

 
Excel now allows sorts on up to sixty-four columns at the same time, which is more of a theoretical limit 
than a practical one for most users. Click on the filter button in the Name field. Select Sort by Color, 
Custom Sort to display the Sort dialog box shown in Figure 9. 
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Figure 9 – Specifying a Sort Order in the Custom Sort Dialog Box 
 

Click Add Level to add another sort criterion. In the Then by box, select Type. In the Sort On box, choose 
Values. Note that a column can be sorted on values, cell color, font color, or cell icon (from an icon set). 
In the Order box, select Z to A. Again, click Add Level to add yet another sort criterion. In the Then by 
box, select Amount. In the Sort On box, choose Values. In the Order box, select Largest to Smallest. The 
owner would like to see his data sorted first on check Type, then Name, and then Amount. Click on the 
row identified as Then by Type. With the row highlighted, click the small gray arrow at the top of the 
dialog box to move Type to the top of the sort order as shown in Figure 9. Partial results of the custom 
sort are displayed in Figure 10. 

 

 
Figure 10 - Table Sorted on Type, Name, and Amount 
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The owner would like you to re-sort the data by check Type, Amount, and then payee Name. To do so, 
re-visit the Sort dialog box and rearrange the sort order. 

 

 

For the next example, clear the active sorts and filters. Position the cursor in the table and select Sort & 
Filter, Clear on the Home tab. Re-filter the table so that only checks written in 2014 are displayed. 
Position the cursor inside the Table and scroll down slowly to the bottom of the table. Watch as the 
table header row approaches the top edge of the worksheet grid, and then becomes embedded in the 
column headings, as shown in Figure 11. In the process, the column headings A, B, C, etc., become Type, 
Date, Num, etc. This innovation insures that table headings never scroll off the screen, eliminating the 
need for freezing panes. 

 

 
Figure 11 - Table Headings Embedded in Worksheet Column Headings 

 
 

Structured Referencing 
Scrolling up to set filters and then down to see totals in a large table, such as a weekly sales table for a 
restaurant chain, is not effective practice. We can use formulas to put the totals at the top of the table, 
so that as we set filters, the results will be plainly visible. In the process, we will further investigate the 
innovation known called structured referencing. Position the cursor in cell I4. Type in the label Total and 
format the label with boldface, right justification, and accounting format. Move right to cell J4 and type 
in the following formula. 

 

=SUBTOTAL(9,WeeklySales[EOW Totals]) 

To perform a case-sensitive sort or to sort across columns, click on the Options button in the 
Sort dialog box. To clear all active sorts and filters, position the cursor in the table and select 
Home, Sort & Filter, Clear. This will reposition the data to its original order. 

 
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Alternatively, build the formula by pointing to the data column. Start the formula and then move the 
cursor slowly to the top edge of the table above the EOW Totals column to be selected. As the cursor 
crosses into the table, it will change from the standard Swiss cross to a black mini arrow, as shown in 
Figure 12. At that point, simply click to select the data column. Note that the process does not select the 
heading or total rows, even if the total row is displayed. A second click will select the entire column 
including the heading and total rows. A dashed border surrounds the range selected for visual 
confirmation. Individual rows can be selected using a similar process. 

 

 
Figure 12 - Using the Mouse to Select a Table Column 

 
 
 

The formula created sums all amounts displayed in the EOW Totals column of the WeeklySales table. As 
the filters are reset, the total displayed will change to reflect the sum of the records displayed. If filters 
are cleared, then the formula will reflect the sum of all weekly sales. 

 

 

Copy the formula in cell J4 to cell J5 and then change the formula in cell J5 to read as shown below. 
 

=SUBTOTAL(1,WeeklySales[EOW Totals]) 
 

Filter the table so that the number of displayed rows varies in length. Note that the mean and total 
formulas displayed at the top of the table change to reflect the filters applied to the table, as shown in 
Figure 13. 

 
 
 
 
 
 
 
 

 
The dashed border identifies 
the range selected. 

As  a  table  is  filtered,  Excel  hides  from  the  user  the  rows  that  are  not  of  interest.  The 
SUBTOTAL function uses function numbers to determine whether the summary calculation 
includes hidden rows. Hidden rows are normally included in summary totals when using 
function numbers 1-11 except when the rows are hidden by active filters, in which case the 
hidden rows are not included in the totals. Hence, it is not necessary to use SUBTOTAL function 
109 to sum filtered tables so that only displayed rows are included in the totals. 

 
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Figure 13 - Creating Totals at the Top of a Table 
 

Structured references are a means of working with table data, both inside and outside the table. 
Formulas built on structured referencing are self-documenting because they specify data elements 
within a table rather than cell references. Here's a formula using structured referencing to display the 
total the EOW Totals column in the WeeklySales table: 

 

=WeeklySales[[#Totals], [EOW Totals]] 
 

Filtering Duplicate Records 
Accountants often face the task of identifying duplicate records – duplicate checks, invoices, bills, or 
purchase orders, etc. Instead of carefully reviewing a printed listing of the documents in question, users 
could employ Excel functionality to complete the task in seconds. In this example, we will use 
conditional formatting to find duplicate check numbers, as shown in Figure 14. 



14 
Copyright © 2018, K2E Canada Inc. Reproduction or reuse for purposes other than a K2 Enterprises’ training event is prohibited. 

 

 
 

Figure 14 - Formatting Duplicate Values 
 

To begin the process of finding duplicate checks, select the data in the Num column using the black mini 
arrow cursor. Then, select Conditional Formatting, Highlight Cells Rules, Duplicate Values from the 
Home tab of the ribbon. In the Duplicate Values dialog box, select Duplicates and accept the default 
color scheme as shown in Figure 17. Click OK to apply the conditional formatting. 

 
Next, filter the Num column to display only the duplicate values. Click the filter box and select Filter by 
Color. Choose Filter by Cell Color and select the pink bar, as shown in Figure 15. If you have ever 
scrolled through a sorted list looking for duplicate check numbers, then you understand the 
effectiveness of the method demonstrated. If you need to look for duplicates across multiple columns, 
use the CONCATENATE function to combine the columns of interest into a new column, and then look 
for duplicates on the newly combined column. 
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Figure 15 - Filtering a Column by Font Color 
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